CDB5532U
CDB5532U Evaluation Board and Software
Features

General Description

 USB Communication with PC

The CDB5532U is an inexpensive tool designed to evaluate the functionality and performance of the CS5532.
The CS5532 datasheet should be read and consulted
when using the CDB5532U evaluation board.

 On-board Microcontroller
 On-board Voltage Reference

The evaluation board includes a C8051F320 microcontroller with a USB interface. The microcontroller controls
the serial communication between the evaluation board
and the PC via the firmware, enabling quick and easy access to all of the CS5532’s registers and functions.

 Evaluation Software
– Register Setup & Chip Control
– FFT Analysis

The CDB5532U includes software for data capture, time
domain analysis, histogram analysis, and frequency domain analysis.

– Time Domain Analysis
– Noise Histogram Analysis
 Interface Header for External Microcontroller
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1. HARDWARE
1.1

Introduction

The CDB5532U evaluation board provides a quick means of evaluating the CS5532 Analog-to-Digital
Converter (ADC). The CS5532 is a highly integrated ∆Σ ADC which uses charge-balance techniques to
achieve 24-bit performance. The CS5532 includes a very-low-noise, chopper-stabilized instrumentation
amplifier (6 nV/sqrt(Hz) @ 0.1 Hz) with selectable gains of 1x, 2x, 4x, 8x, 16x, 32x, and 64x. This ADC
also includes a fourth order ∆Σ modulator followed by a digital filter which provides twenty selectable output word rates of 6.25 Hz, 7.5 Hz, 12.5 Hz, 15 Hz, 25 Hz, 30 Hz, 50 Hz, 60 Hz, 100 Hz, 120 Hz, 200 Hz,
240 Hz, 400 Hz, 480 Hz, 800 Hz, 960 Hz, 1.6 kHz, 1.92 kHz, 3.2 kHz and 3.84 kHz (XIN = 4.9152 MHz).
The CDB5532U is shipped with a CS5532 device soldered at U2. However, the CS5531, CS5533, or
CS5534 can be soldered in this same location. The CDB553xU software supports all four devices.

1.2

Evaluation Board Overview

The CDB5532U evaluation board is partitioned into two main sections: analog and digital. The analog section consists of the CS5532 and a precision voltage reference. The digital section consists of the microcontroller, the reset circuitry, and the USB interface. The board also has power supply connections which
accommodate all of the various supply options of the CS5532.
The evaluation board’s analog section operates from either a single +5 V, dual ±2.5 V, or dual ±3 V power
supply. The evaluation board interfaces the CS5532 to an IBM® compatible PC with a USB interface. To
accomplish this, the board comes equipped with a microcontroller and a USB cable which physically interfaces the evaluation board to the PC. The software provides easy access to the internal registers of the
CS5532, and provides a means to display and evaluate the performance of the ADC in the time domain
or the frequency domain.

1.2.1

Analog Section

The CS5532 is a high-precision ∆Σ ADC designed to accurately measure one or two fully-differential analog voltage inputs while operating from a 4.9152 MHz crystal.
The evaluation board provides separate screw terminals to connect signals to each of the two input channels. The input screw terminals are labeled as AIN1 & AIN2, which correspond to physical input channels
1 & 2, respectively. A simple RC network on each channel filters the sensor’s output to reduce any interference picked up by the input leads. The -3 dB corner of the filter is approximately 52 kHz differential and
56 kHz common mode. Figure 7 illustrates the schematic of the analog section.
The evaluation board provides three voltage reference options for VREF+ and VREF-. The three reference options for VREF+ include: VA+, the on-board LT1019 voltage reference, and external input (J12).
Table 1 illustrates the options available. With the J17 jumper in position VA+, the reference is supplied by
the VA+ analog supply. With the J17 jumper in position LT1019, the LT1019 provides a +2.5 V reference
(the LT1019 was chosen for its low drift, typically 5 ppm/°C). By setting the J17 jumper to position VREF+,
the user can supply an external voltage reference to J12’s VREF+ input.
The three reference options for VREF- include: VA-, GND, and external input (J12). Table 2 illustrates the
options available. With the J18 jumper in position VA-, the reference is supplied by the VA- analog supply.
With the J18 jumper in position GND, the VREF- pin is connected to the board ground. By setting the J18
jumper to position VREF-, the user can supply an external voltage reference to J12’s VREF- input.
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Table 1. Voltage Reference Selection for VREF+
Reference

Description

J17

VA+

Selects Positive
Analog Power
Supply

VA+ O
LT1019 O
REF+ O

O VREF+
O VREF+
O VREF+

LT1019

Selects on-Board
LT1019 Reference
(5ppm/°C)

VA+ O
LT1019 O
REF+ O

O VREF+
O VREF+
O VREF+

VREF+

Selects External
VA+ O O VREF+
Reference Source LT1019 O O VREF+
REF+ O O VREF+
(J12)

Table 2. Voltage Reference Selection for VREF-

1.2.2

Reference

Description

J18

VA-

Selects Negative
Analog Power
Supply

VA- O
GND O
REF- O

O VREFO VREFO VREF-

GND

Selects Board
Gnd

VA- O
GND O
REF- O

O VREFO VREFO VREF-

VREF-

Selects External
Reference Source
(J12)

VA- O
GND O
REF- O

O VREFO VREFO VREF-

Digital Section

Figure 8 illustrates the schematic of the digital section. It contains the microcontroller, USB interface, EEPROM, JTAG header, reset circuitry, and an external interface header. The microcontroller interfaces the
SPI™ and MICROWIRE™ compatible serial port of the CS5532 with the USB connection to the PC. Note
that the SCLK and SDI signals are level shifted to support both +3.3 V and +5 V digital operation.
The microcontroller EEPROM is used to store firmware. An external interface header, J19, is provided to
allow the CDB5532U to be interfaced with an external microcontroller. To use this serial interface, the
0 ohm resistors R9, R10, R23, and R27 should be removed to disconnect the on-board microcontroller
from the serial interface.

1.2.3

Power Supply Section

Figure 9 illustrates the power supply connections to the evaluation board. VA+ supplies the positive analog supply for the CS5532 and the LT1019 reference. Header J14 allows the VA+ supply to be sourced
from either the VA+ binding post (J2), or from the +5 V binding post (J3). VA- supplies the negative analog
supply for the analog section. Header J13 allows the VA- supply to be sourced from either the VA- binding
post (J1), or connected to the board ground. Note that the VA- supply should be connected to ground
when powering the CDB5532U from a single +5 V analog supply. VD+ supplies the digital section of the
ADC and level shifters. Header J15 allows the VD+ supply to be sourced from the VD+ binding post (J5),
the +5 V binding post (J3), or the regulated +3.3 V supply derived from the microcontroller. The +5 V binding post supplies the microcontrollers internal regulator.
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2. SOFTWARE
The evaluation board comes with software and a USB cable to link the evaluation board to the PC. The
software is designed to run under Windows® 2000 or later.

2.1
2.1.1

Installation Procedure
CDB553xU GUI Software Installation Instructions
1. Ensure the CDB5532U USB cable is disconnected from the PC.
2. Open GUI software installation folder CDB553x_cvidistkit.Eval5534U Ö Volume1.
3. Run SETUP.EXE by double clicking on the filename.
4. Select Next, I Accept License Agreement, Next, Next, Finish.

2.1.2

Installing the USB Drivers
1. Apply power to the CDB5532U. Press and release the Reset switch, S1.
2. Use the included USB cable to connect the CDB5532U to the PC. The PC operating system should
automatically launch the Found New Hardware wizard.
3. From the installation wizard, select Install from a list or specific location (Advanced). Select Search
for the best driver in these locations.
4. Select Include this location in the search.
5. Click the Browse... button.
6. Go to folder C:/Program Files/Eval5534U/Driver and click OK.
7. Press the Next button.
8. A Hardware Installation dialog will appear. Press Continue Anyway.
9. Select Browse... and go to folder C:/Program Files/Eval5534U/Driver. Press Open.
10. A Files Needed dialog will appear. Press OK.
11. The Found New Hardware wizard will appear. Press the Finish button.

2.1.3

Running the GUI

Run the program by selecting Start Ö All Programs Ö Eval5534U Ö Eval5534_U.

2.2

Using the Software

Before launching the evaluation program, the user should set up the CDB5532U evaluation board, select
the proper jumper settings as described in Section 1, ensure the board is connected to an open USB port
on the PC, and apply power to the board.

DS807DB1
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2.2.1

Start-Up Window

When the evaluation program is launched, the start-up window will appear. This window contains information concerning the software’s title, revision number, copyright date, etc.

Figure 1. CDB553xU Start-Up Screen

At the top of the screen is a menu bar which displays user options. The menu bar item Window is initially
disabled to prevent conflicts with other serial communications devices. After selecting the data source in
the Options menu, the Window menu item will become available.

2.2.1.1

Options

The Options menu item allows the user to select the source of the data and to configure the appearance
of the graphs. The user has two options for the data source: USB and File. If USB is selected, the evaluation software will be ready to communicate with the CDB5532U via the USB connection. At this point,
the Part menu item is active and the appropriate CS553x device can be selected. If File is selected, the
evaluation software will prompt the user to select the appropriate data file. This option allows the user to
view previously captured data without having a CDB5532U connected to the PC. See section ‘Retrieving
Saved Data From a File” on page 12 for more details.
The Plot Options window can be accessed by pulling down the Options menu and clicking on Plot Options.
In this window, the user can change the background color, the plot line color, and the peak indicator color.
The Harmonic and Peak indicators can also be turned on or off in this window.
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2.2.1.2

Window Menu

After the user selects the appropriate setup, the Window option becomes available in the Start-up window.
The Window pull-down has three options: Start-Up Window, Setup Window, and Data Collection Window.

2.2.2

Setup Window

The Setup window allows the user to access the internal registers of the CS5532. See Figure 5.

Figure 2. CDB5532U Setup Window

In the Setup window, all of the ADC’s registers are displayed as hexadecimal values. The configuration
register’s settings are also defined in this window.
Update Registers: The Update Registers button will read all the register values from the CS5532 and
update the hexadecimal values displayed on the screen. It is a good idea to press the Update Registers
button when entering the Setup window, or after modifying any registers to reflect the current status of the
part.
Reset Serial Port: When this button is selected, the software will send the synchronization sequence discussed in the CS5532 datasheet to the ADC. This sequence brings the CS5532’s serial port back to the
command mode, but does not reset any of the registers in the part.
Reset Part: When this button is selected, a ‘1’ is written to the RS bit in the configuration register to reset
the part. After a reset, the registers will all return to their default values as discussed in the CS5532
datasheet.
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Read Data: This button will instruct the ADC to begin performing repeated single (fully-settled) conversions on the setup channel specified by the Setup Register box. The results of the most-recent conversion
are displayed in the Last Conversion box, as well as the Channel and Overflow indicators for each conversion. The software will halt the data collection process when the user clicks the Stop button.
Configuration Register: In the Configuration Register box, the contents of the configuration register are
displayed, and can be modified by typing a hexadecimal value in the Hexadecimal: box, or by changing
any of the values below the Hexadecimal: box to the desired settings. Note: When changing the value of
the reset system bit to ‘1’ (RS, bit 29 in the configuration register), the part will be reset, and all registers
will return to their default values. It is a good idea to click the Update Registers button after performing a
reset to update the screen with the new register values.
Channel Setup Registers: In the Channel Setup Registers box, both channel setup registers are displayed in hexadecimal. These registers can be modified from the Channel Setup Register window, which
is accessed by selecting the Edit CSRs button.
Channel Setup Register Window: In the Channel Setup Register window (Figure 3), each of the two
CSRs can be decoded and modified. The blue box at the top of the window allows the user to switch between CSRs. Each 32-bit CSR contains two 16-bit “Setups” which are decoded in the two boxes below
the hexadecimal value. The currently displayed CSR can be modified by either typing a value directly in
the Hexadecimal: box or by changing the decoded values in the individual setup boxes.

Figure 3. CDB5532U Channel Setup Register Window

Offset / Gain Registers: In the Offset / Gain Registers box, the offset and gain registers for all channels
are displayed in hexadecimal. These registers can all be modified in the Calibration window, which is accessed when the user selects the Calibration Window button.
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Calibration Window: The Calibration window (Figure 4) permits the user to access the calibration registers for each channel of the CS5532 and also perform self and system offset or gain calibrations on either
of the channels. Prior to performing calibrations however, the channel setup registers should be modified
to configure the part for the desired operating mode (see the section ‘Setup Window” on page 7 for more
details). Note that offset calibration should be performed before gain calibration to ensure accurate results. Refer to the CS5532 datasheet for more details.

Figure 4. CDB5532U Calibration Window

Self Offset or Gain Calibrations:
1) Pull down the Self Offset or Self Gain box, and select the setup number you want to use to calibrate the channel.
2) The offset and gain register values will automatically update when the calibration is completed.
System Offset Calibrations:
1) Attach a grounded input to the physical channel you want to calibrate. Note that the grounded input
must be within the common mode range of the particular amplifier (1x-64x) for proper operation.
2) Pull down the System Offset box, and select the setup number you want to use to calibrate the
channel.
3) When the calibration is complete, the screen will automatically update the offset and gain registers
with the new values.
System Gain Calibrations:
1) Attach a full-scale input to the physical channel you want to calibrate.
2) Pull down the System Gain box, and select the setup number you want to use to calibrate the
channel.
3) When the calibration is complete, the screen will automatically update the offset and gain registers
with the new values.
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2.2.3

Data Collection Window

The Data Collection window (Figure 5) allows the user to collect sample sets of data from the CS5532 and
analyze them using time domain, FFT, and histogram plots. The Data Collection window is accessible
through the Window menu, or by pressing <F3>.

Figure 5. CDB5532U Data Collection Window

Time Domain / FFT / Histogram Selector: This menu selects the type of data processing to perform on
the collected data and display in the plot area. Refer to the section ‘Analyzing Data” on page 12 for more
information.
Collect Button: This button will collect data from the part, to be analyzed in the plot area. See the section
‘Collecting Data Sets” on page 12 for more information.
Config Button: This button will bring up the Configuration window, in which the user can modify the data
collection specifications. See the discussion of the Configuration window in this document.
Output Button: This button will bring up a window in which the user can output the data to a data file for
later use, print out a plot, or print out the entire screen.
Zoom Button: This button allows the user to zoom in on the plot by selecting two points in the plot area.
Click the Restore button to return to the normal data plot, or press the Zoom button again to zoom in even
further.
Setup Select Box: This box determines the setup number to use when performing conversions. See the
CS5532 datasheet for more details on the functionality of the channel setup registers.
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2.2.4

Configuration Window

The Configuration window allows the user to set up the data collection and analysis parameters. See Figure 6.

Figure 6. CDB5532U Configuration Window

Number of Samples: This box allows the user to select the number of samples to collect, between 16
and 32,768.
Average: When doing FFT processing, this box will determine the number of FFTs to average. FFTs will
be collected and averaged when the Collect button is pressed.
FFT Window: This box allows the user to select the type of windowing algorithm for FFT processing. Windowing algorithms include the Blackman, Blackman-Harris, Hanning, 5-term Hodie, and 7-term Hodie.
The 5-term Hodie and 7-term Hodie are windowing algorithms developed at Cirrus Logic. This selection
has no effect on Time Domain or Histogram analysis.
Histogram Bin Width: This box allows for a variable "bin width" when plotting histograms of the collected
data. Each vertical bar in the histogram plot will contain the number of output codes contained in this box.
Increasing this number may allow the user to view histograms with larger input ranges.
Crystal Frequency: The CDB5532U evaluation board comes equipped with a 4.9152 MHz crystal. If the
user chooses to replace this with a crystal of a different frequency, the number in this box can be modified
to provide more accurate timing and FFT information.
Grounded FFT Test: When turned on, this function will generate an ideal full-scale sine wave for calculation purposes. This will enable the software to calculate the signal-to-distortion and signal-to-noise of
the converter with a simulated ideal full-scale sine wave source, although the converter is grounded.
Accept: When this button is selected, the current settings will be saved, and the user will return to the
Data Collection Window.
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2.3

Collecting Data Sets

To collect a sample data set:
1) In the Data Collection window, select the Config button to bring up the Configuration window and
view the current settings.
2) Select the appropriate settings from the available options (see the section ‘Configuration Window”
on page 11) and select the Accept button.
3) The Data Collection window should still be visible. In the Setup box, select the setup number you
want to use to perform conversions.
4) Click the Collect button to begin collecting data.
5) Data is sent directly to the PC through the USB cable. Depending on the value of the WR bits in
the selected setup and the number of samples being collected, this process may take several minutes. The process can be terminated by pressing the Stop button, but if this is done, the user
should also press the Reset switch on the CDB5532U board to bring the microcontroller out of the
collection routines.
6) Once the data has been collected, it can be analyzed, printed, or saved to disk.

2.4

Saving and Printing Data

Once collected, data can be printed or saved to a file for later use. To save or print data, click on the Output
button in the Data Collection window. A small panel will pop up with three options:
1) Output Data File: Brings up the File Save dialog box, which allows the data to be saved to a file.
2) Print Screen: Prints the entire display, including the calculated statistics.
3) Print Graph: Prints the information in the plot area. The statistical information is not printed.

2.5

Retrieving Saved Data From a File

To load a previously saved file:
1) Pull down the Setup menu and select Disk. A file menu will appear.
2) Find the data file in the list and select it. Press the Select button to return.
3) Go to the Data Collection window, and press the Collect button.
4) The data from the file should appear on the screen. To select a different file, repeat the procedure.

2.6

Analyzing Data

The evaluation software provides three types of analysis - time domain, frequency domain, and histogram.
The time domain analysis processes acquired conversions to produce a plot of conversion sample number versus magnitude. The frequency domain analysis processes acquired conversions to produce a
magnitude versus frequency plot using the fast-Fourier transform (results up to Fs/2 are calculated and
plotted). Also, performance parameters are also calculated and displayed. The histogram analysis test
processes acquired conversions to produce a histogram plot. Statistical noise calculations are also calculated and displayed.
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2.7

Histogram Information

The following is a description of the indicators associated with histogram analysis. Histograms can be plotted
in the Data Collection window by setting the Time Domain / FFT / Histogram selector to Histogram.
BIN: Displays the x-axis value of the cursor on the histogram.
MAGNITUDE: Displays the y-axis value of the cursor on the histogram.
MAXIMUM: Indicator for the maximum value of the collected data set.
MEAN: Indicator for the average of the data sample set.
MINIMUM: Indicator for the minimum value of the collected data set.
STD. DEV.: Indicator for the standard deviation of the collected data set.
VARIANCE: Indicates the variance for the current data set.

2.8

Frequency Domain Information

The following describe the indicators associated with FFT (Fast Fourier Transform) analysis. FFT data can
be plotted in the Data Collection window by setting the Time Domain / FFT / Histogram selector to FFT.
FREQUENCY: Displays the x-axis value of the cursor on the FFT display.
MAGNITUDE: Displays the y-axis value of the cursor on the FFT display.
S/D: Indicator for the signal-to-distortion ratio, 4 harmonics are used in the calculations (decibels).
S/N+D: Indicator for the signal-to-noise + distortion ratio (decibels).
SNR: Indicator for the signal-to-noise ratio, first 4 harmonics are not included (decibels).
S/PN: Indicator for the signal-to-peak noise ratio (decibels).
# of AVG: Displays the number of FFTs averaged in the current display.

2.9

Time Domain Information

The following controls and indicators are associated with Time Domain analysis. Time domain data can
be plotted in the Data Collection window by setting the Time Domain / FFT / Histogram selector to Time Domain.
COUNT: Displays current x-position of the cursor on the time domain display.
MAGNITUDE: Displays current y-position of the cursor on the time domain display.
MAXIMUM: Indicator for the maximum value of the collected data set.
MINIMUM: Indicator for the minimum value of the collected data set.
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Figure 7. Analog Section
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Figure 9. Power Supply
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Figure 10. Top Silkscreen
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Figure 11. Top Routing
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Figure 13. Bottom Silkscreen
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